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Greetings from the Graduate Coordinator 

 

On behalf of the Department of Sociology, welcome to the Sociology MA Program! This 

handbook provides information for current and potential students about our graduate program, 

including admissions, requirements, thesis and non-thesis projects, internships, and 

assistantships.  We also include some guidance for how to navigate the program and the thesis 

project. As Graduate Coordinator, I am responsible for screening applicants for admission, 

recruiting new students, advising students, assigning Graduate Assistantships (GA), and 

arbitrating any general problems that involve graduate students.  So if you have any questions 

about our program, please feel free to contact me (see below for contact information). 

 

Our Sociology MA program offers a structured two-year series of courses that provide a strong 

foundation in sociological theory, research methods, and statistics. The Sociology Department at 

WSU emphasizes a social justice perspective, and our students develop insights about the effects 

of social structures on individual lives and communities.  For example, our faculty research 

focuses on issues such as teen dating violence, sexual minority well-being, runaway youth, 

gentrification, educational policy, and caregiving in later life. Our program prepares graduates 

for employment in a number of different fields. Some of our graduates are now teaching 

Sociology or related disciplines at area colleges, including Wichita State, Emporia State, and 

Hutchinson Community College. Others have gone on to pursue careers in research at places like 

the KU School of Medicine, Accuweather, and the Census Bureau. We also have previous 

students employed in the non-profit sector and social services, both locally (Wichita Area Sexual 

Assault Center) and internationally (CARE International Tanzania). Finally, many of our 

students go on to pursue PhD programs at very competitive universities across the nation, 

including Penn State, Purdue, and Bowling Green among others. 

 

The Department of Sociology offers a Master of Arts degree with both a thesis and non-thesis 

option, and you will find information about both below. Given the structure course of study in 

our program, courses usually must be completed in a specific order. Each of these required 

courses provides foundational research skills in theory, methodology and statistics, and they 

prepare students for independent research (thesis project) or applied settings (internship).  

If you have any questions, you may contact me through any of the methods below: 

 

Dr. Jennifer Pearson, Graduate Coordinator 

Pronouns: She/Her/Hers 

Department of Sociology 

Wichita State University 

1845 Fairmount, Campus Box 25 

Wichita, KS 67260-0025 

 

Email: jennifer.pearson@wichita.edu  

Phone: (316)978-7145  

mailto:jennifer.pearson@wichita.edu
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Graduate Faculty and Areas of Specialization 

 

Full-Time Faculty 

 

Chase M. Billingham (Ph.D., Northeastern University). Assistant Professor. Urban sociology, 

education, racial stratification, public policy, quantitative methods. 

 

Contact: chase.billingham@wichita.edu, 316-978-7144 

 

Jodie L. Hertzog (Ph.D., Purdue University). Department Chair and Undergraduate Program 

Coordinator.  Associate Professor. Family & Intimate Relationships, Gender, Intimate Partner 

Violence Prevention, Work-Family Interfaces.  

 

Contact: jodie.hertzog@wichita.edu, (316) 978-7155 

 

Twyla J. Hill (Ph.D., University of California-Irvine). Professor. Sociology of Aging, Sociology 

of Families, Sociology of Law, Research Methods. 

 

Contact: twyla.hill@wichita.edu, (316) 978-7151 

 

Charles S. Koeber (Ph.D., State University of New York, Binghamton).  Associate Professor. Job 

Loss, Work, Labor Process, Labor Markets, Stratification/Inequality, Consumption. 

 

Contact: chuck.koeber@wichita.edu, 316) 978-7147 

 

Jennifer Pearson (Ph.D., University of Texas at Austin). Graduate Coordinator. Associate 

Professor. Gender and Sexualities, Education, Adolescence and the Transition to Adulthood. 

 

Contact: jennifer.pearson@wichita.edu, (316) 978-7145 

 

Kathleen M. O'Flaherty Perez (Ph.D., Purdue University). Associate Professor. Research 

Methods, Urban, Demography. 

 

Contact: kathy.perez@wichita.edu, (316) 978-7152 

 

Lisa Thrane (Ph. D., Iowa State University). Associate Professor. Deviance, Mental Health, 

Homeless and Runaway Youth, Research Methods. 

 

Contact: lisa.thrane@wichita.edu, (316) 978-7150 

https://www.wichita.edu/academics/fairmount_college_of_liberal_arts_and_sciences/sociology/billingham.php
mailto:chase.billingham@wichita.edu
https://www.wichita.edu/academics/fairmount_college_of_liberal_arts_and_sciences/sociology/Hertzog.php
mailto:jodie.hertzog@wichita.edu
https://www.wichita.edu/academics/fairmount_college_of_liberal_arts_and_sciences/sociology/hill.php
mailto:twyla.hill@wichita.edu
https://www.wichita.edu/academics/fairmount_college_of_liberal_arts_and_sciences/sociology/koeber.php
mailto:chuck.koeber@wichita.edu
https://www.wichita.edu/academics/fairmount_college_of_liberal_arts_and_sciences/sociology/Pearson.php
mailto:jennifer.pearson@wichita.edu
https://www.wichita.edu/academics/fairmount_college_of_liberal_arts_and_sciences/sociology/perez.php
mailto:kathy.perez@wichita.edu
https://www.wichita.edu/academics/fairmount_college_of_liberal_arts_and_sciences/sociology/Thrane.php
mailto:lisa.thrane@wichita.edu
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Full-Time Teaching Faculty 

 

Jodie Simon (MA, Wichita State University).  Associate Teaching Educator.  

Contact: jodie.simon@wichita.edu. 

Shirlene Small (MA, Wichita State University). Associate Teaching Educator. 

Contact: shirlene.small@wichita.edu. 

 

Part-time Lecturers 

 

Deborah Beat (MA, Wichita State University). 

 

Eunita Jackson (MA, Emporia State University). 

 

Tisha Whitehead (MA, Wichita State University). 

 

Other Affiliated Faculty 

 

Ronald R. Matson (Ph.D., University of Colorado).  Emeritis Professor. Gender Studies, 

Masculinity, Intimate Relationships, Parenting. 

Mark Vermillion (Ph.D. Oklahoma State University).  Department of Sports Management, Chair 

& Associate Professor. 

David W. Wright (Ph.D., Purdue University). Associate Vice President for Academic Data 

Systems and Strategic Planning & Professor. Stratification and Class Analysis, Marxism, 

Employment and Income, Theory, Graduate Data Management and Statistics.  

mailto:Jodie.simon@wichita.edu
mailto:shirlene.small@wichita.edu
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Application Process 
 

Graduate School Application and Requirements: 

Students who wish to pursue graduate education in the department of Sociology must first apply 

to the WSU Graduate School online. This application is then forwarded to and screened by the 

graduate coordinator in the department of Sociology. Each applicant must submit official 

transcripts of all previous academic work, including credits earned at community colleges or 

work transferred to another institution. Instructions for how to submit official transcripts are 

provided in the Admission section of the WSU Online Graduate Catalog.  

The minimum Graduate School requirements are: 

 Bachelor’s degree from a regionally accredited institution or a recognized institution in 

another country whose requirements for the bachelor’s degree are substantially equivalent 

to a U.S. bachelor’s degree. 

 Grade point average of at least 2.750, including any post bachelor’s graduate work 

 No more than 9 credit hours of background deficiencies in the desired field of graduate 

study. 

 Proof of English proficiency may be required for U.S. citizens or permanent residents 

who are non-native English speakers. The International Applicants section of the 

Graduate Catalog provides more information about these requirements. 

 

The Graduate School offers two admission statuses, degree and nondegree, to accommodate 

qualified students desiring to pursue graduate degrees as well as those simply desiring to earn 

graduate credit for personal and professional reasons. See the Admission Requirements section 

of the WSU Online Graduate Catalog for more complete information on the above requirements 

and the degree level options. 

Department of Sociology Graduate Admission Requirements: 

In addition to the Graduate School requirements for admission, the Department of Sociology 

requires: 

 Overall grade point average (GPA) of at least 3.00 

 One college algebra course 

 At least 12 hours in social science courses including: 

o an introductory sociology course 

o one social statistics course 

o one research methods course, and 

o one theory course 

Students without these required courses in social statistics and/or theory may be admitted 

provisionally, but deficiencies must be removed in the first year of graduate study.  

 Three letters of reference from professors who are familiar with the student's academic 

course work 

 A typed, double-spaced statement of purpose (approximately 500 words) articulating the 

student's area of research interests and academic/career goals. 

 

http://www.wichita.edu/apply
http://catalog.wichita.edu/graduate/admission-graduate-study/
http://catalog.wichita.edu/graduate/admission-graduate-study/information-international-applicants/
http://catalog.wichita.edu/graduate/admission-graduate-study/admission-requirements/
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Graduate Degree Options and Requirements: 
 

The department offers both a thesis and non-thesis option.  Unique among most graduate 

programs, the thesis and non-thesis options in the Department of Sociology are similar in 

required course work, level of difficulty, content and written structure. Both options require the 

completion of an individual research project and submission of a final document (see 

expectations and requirements below). The primary difference between the two options is that 

the thesis option requires you to form a thesis committee (two members from the Sociology 

Department and one outside member from another WSU department), pass an oral defense, and 

produce a document that meets Graduate School format requirements. The non-thesis option on 

the other hand, requires a more applied experience, either through completion of an internship or 

a directed project.  

Thesis Option: Students in the thesis program must complete a total of 32 credit hours, 

including: 

SOC 860 Proseminar 3 

SOC 811 Advanced Research: Quantitative Methods 3 

SOC 812 Advanced Research: Qualitative Methods 3 

SOC 845 Seminar in Sociological Theory 3 

SOC 875/876 Thesis Hours 6 

 800-level seminar 3 

 Electives (or prerequisites if required) 500-level or 

above 

11 

Total 32 

 

Non-Thesis Option: The non-thesis program allows more flexibility in required coursework 

(with Graduate Coordinator approval) but with a total of 32 credit hours. Expectations for this 

coursework include: 

SOC 860 Proseminar 3 

SOC 811 Advanced Research: Quantitative Methods 3 

SOC 812 Advanced Research: Qualitative Methods 3 

SOC 845 Seminar in Sociological Theory 3 

SOC 851/SOC 

781N 

Project Hours or Internship Hours 6 

 One 800-level seminar 3 

 Electives (or prerequisites if required) 500-level 

or above 

11 

Total 32 

 

Dismissal and Transfer to Non-Degree Status: 

A Sociology graduate student may be dismissed from the program for any of the following 

reasons: 
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 student's GPA drops below 2.00 

 student does not make satisfactory progress toward degree completion 

 student enters the program on probationary status and fails to achieve a cumulative GPA 

of 3.00 after nine hours of course work 

 student is placed on probation and fails to achieve a cumulative GPA of 3.00 after nine 

hours of course work 

 student violates the Student Code of Conduct as outlined in the WSU Policies and 

Procedures Manual 

 

A Sociology graduate student in full-standing may be transferred to non-degree status for any of 

the following reasons: 

 student does not enroll in any sociology course work for more than 12 months 

 student fails to enroll within 12 months after admission into the program 

 student fails to receive consent of the instructor for any Independent/Directed Study 

course 

 student fails to receive their advisor's expressed approval for course enrollment 

 student does not exhibit satisfactory progress in their program as evidenced by low GPA 

(under 3.00), excessive incompletes, insufficient class attendance, and/or failure to meet 

the six year completion limit 

 

Required Coursework 

 

The core courses of the Sociology graduate curriculum should generally be taken in the 

following order: 

SOC 860.  Proseminar - Sociology (3). Examines the academic roles of sociologists, the fields 

of study and types of research. Usually offered fall semester only. Fulfills the university's 

professional and scholarly integrity training requirement covering research misconduct, 

publication practices and responsible authorship, conflict of interest and commitment, ethical 

issues in data acquisition, management, sharing and ownership. Prerequisite: departmental 

consent. 

SOC 812.  Advanced Research: Qualitative Methods (3). Graduate students deepen their 

understanding of the research process as they are introduced to qualitative methods, 

methodology and analysis. Students learn to address methodological issues by developing a pilot 

project requiring them to apply their understanding of qualitative methods, sampling and coding. 

Through this process, students are prepared to compare the strengths and limitations of 

quantitative, qualitative and mixed method approaches while becoming critical consumers of 

qualitative research. Prerequisite: SOC 512 or departmental consent. 

SOC 845.  Seminar in Sociological Theory   (3). A comprehensive survey of contemporary 

sociological theories and their classical roots. Emphasis on theories applicable to students' thesis 

and nonthesis projects. Generally offered spring semester only. Prerequisite: departmental 

consent. 

http://webs.wichita.edu/inaudit/ch8_05.pdf
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SOC 811.  Advanced Research: Quantitative Methods   (3). Seminar course designed to 

provide graduate students with the conceptual tools and methodological skills needed to conduct 

quantitative sociological research. Students are introduced to sampling, measurement and data 

management issues. In addition, students gain experience with statistical software packages 

using large-scale data sets. Prerequisite: departmental consent. 

Students will take one of the following in their 3rd semester: 

SOC 875.  Thesis   (1-3). Thesis preparation. 

Or 

SOC 851.  Directed Project   (1-3). A project conducted under the supervision of an academic 

adviser for the nonthesis option. Requires the completion of a written report and an oral 

presentation of the research to the faculty. Prerequisite: consent of academic adviser. 

Or 

SOC 781N.  Sociological Practice Internship   (1-3). Integrates academic theory with planned 

professional experience providing students with practical skills training under academic 

supervision to complement the student’s academic program. Individualized programs must be 

formulated in consultation with, and approved by, appropriate faculty sponsors as well as the 

Career Development Center. Repeatable for credit. Graded Cr/NCr. 

Students will take one of the following in their 4th semester: 

SOC 876.  Thesis   (1-3). Thesis preparation. 

Or 

SOC 851.  Directed Project   (1-3). A project conducted under the supervision of an academic 

adviser for the nonthesis option. Requires the completion of a written report and an oral 

presentation of the research to the faculty. Prerequisite: consent of academic adviser. 

Or 

SOC 781N.  Sociological Practice Internship   (1-3). Integrates academic theory with planned 

professional experience providing students with practical skills training under academic 

supervision to complement the student’s academic program. Individualized programs must be 

formulated in consultation with, and approved by, appropriate faculty sponsors as well as the 

Career Development Center. Repeatable for credit. Graded Cr/NCr. 
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Course Sequencing 

 

Below is the typical sequencing of courses. 60% of hours must be 700 or above.  Full time 

enrollment is 9 credit hours a semester. 

Fall Year 1 (1st semester) 

i. Proseminar (860) - 3 credit 

ii. Qualitative Methods course (812) – 3 

credit  

iii. Elective 

Or 

Statistics (713) - 3 credit 

 

Spring Year 1 (2nd  semester) 

i. Theory (845) -3 credit 

ii. Quantitative Methods course (811) - 

3 credit 

iii. Elective 

Or 

Theory (711) - 3 credit  

 

Fall Year 2 (3rd semester) 

i. Thesis hours (875) -3 credit  

Or 

Directed research (851) -3 credit  

Or 

Sociological Internship (781N) 

ii. Elective 

iii. Elective 

 

Spring Year 2 (4th semester ) 

i. Thesis hours (876) -3 credit  

Or 

Directed research (851) -3 credit  

Or 

Sociological Internship (781N) 

ii. 1 or more Electives 
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Thesis Structure and Requirements 
 

All students pursuing a thesis option will be required to hold a research planning meeting with all 

members of their thesis committee in order to outline the research plan with members, seek 

guidance and potential design expectations, and obtain committee approval prior to submitting 

IRB materials and engaging in the research process.  Students should schedule this research 

planning toward the beginning of the semester they first enroll in thesis hours (usually in the Fall 

semester of their second year).  

The final thesis should include an extensive literature review justifying the project and situating 

it within the larger body of relevant research, as well as a comprehensive discussion of methods, 

results, limitations, implications, and conclusions.  

Below are some general guidelines for quantitative and qualitative thesis projects.  
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Guidelines for Quantitative Thesis Options 
 

As a means of clarifying general expectations for the quantitative research option, general 

parameters for different types of quantitative projects were developed by the quantitative 

research subcommittee.  

Basic Research 

For students conducting basic research, the student and their major advisor should review and 

agree upon a research plan including central research questions, preliminary hypotheses, the 

dataset to be used, and appropriate statistical techniques.  This research plan will then be 

presented to the student’s thesis committee for approval before submitting IRB materials and 

engaging in the research process.  

Students will use secondary data to facilitate timely completion of their thesis project and MA 

degree. Datasets should come from widely accepted social science sources (such as ICPSR or 

IPUMS) and should have large samples, such as those that would be publishable in peer-

reviewed academic journals. An alternative approach may be combining data from multiple 

sources into a unique dataset.  

Variables selected will be guided by a review of the relevant literature as well as data limitations, 

and analyses will include appropriate univariate, bivariate, and multivariate statistical techniques. 

The quality of analysis and presentation of findings should be similar to a typical social science 

journal article.  

Evaluation/Applied Research 

For students conducting evaluation or applied research, the student and their major advisor 

should review and agree upon a research plan including central research questions, preliminary 

hypotheses, the data to be used, and appropriate statistical techniques.  These projects may use 

already existing data from an agency or program, or quantitative data may be collected or 

compiled by the student.  Given that these projects may have more variation in substance and 

form than basic research, research plans may need more input from other thesis committee 

members and/or agencies or programs associated with the data.  This research plan will then be 

presented to the student’s thesis committee for approval before submitting IRB materials and 

engaging in the research process. 

The amount of data should be appropriate to the project. Variables selected should be driven by 

the goals of the project as well as a review of the relevant literature, and analyses will include 

appropriate univariate and bivariate statistical tests.  Multivariate analyses also may be suitable, 

depending on the project.  For these types of projects, an executive summary, recommendations 

for implementation, and other documents appropriate for policy papers may be expected as well.  
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Guidelines for Qualitative Thesis Options 

 

Given the emergent and potentially unique parameters of qualitative research projects, the 

Qualitative Research subcommittee proposes that students conducting a qualitative thesis option 

be required to hold a research planning meeting with all members of their thesis committee in 

order to outline the research plan with members, seek guidance and potential design 

expectations, and committee approval prior to submitting IRB materials and engaging in the 

research process.   

Interviews & Focus Group-Based Research 

We recommend these guidelines for interviews which provide parameters for data collection 

techniques, analytical process, and documentation.  

For students conducting interview based research (individual or group), the subcommittee 

recommends no fewer than ten semi-structured, 1 hour, in-depth interviews to provide for 

sufficient diversity and recognition of essential patterns in the data.  We determined that there 

should be a systematic analytical process that delineated the coding methodology. While we 

acknowledge different methods of uncovering emergent themes, we encourage the use of 

formalized data management software.  Common Computer Assisted Qualitative Data Analysis 

(CAQDA) options include software such as Excel, Dedoose, N-Vivo, or Atlas-ti for managing 

and examining the reliability of the coding schema. In order to demonstrate a thorough grasp of 

the data, we believe that interviews should be transcribed by the graduate student with faculty 

advisor oversight.  An interview protocol would be included as an appendix to the thesis along 

with coding examples rather than a complete transcripts of the interviews.  

The subcommittee also established a parallel structure for the evaluation of focus group or other 

forms of group interviews with the recommendation that at least two semi-structured 1-hour 

focus groups with no less than five persons per session would be equivalent. All other interview 

guidelines would remain the same with the exception that an abridged version of the transcript 

would excise tangential discussion not linked to the research question and make it easier for 

analysis.   

Ethnographic Research 

For students conducting ethnographic research, the student’s thesis committee should review and 

agree upon a somewhat focused research plan including information regarding central research 

questions, research location(s) and protocol, length of time in the field, and plans for ensuring the 

safety of the student. 

While the final research plan will be developed and agreed upon by the student and the 

committee, it is expected that students engaging in ethnographic research will spend no fewer 

than 20 hours in the field conducting direct observation.  This does not include the time 

dedicated to writing, organizing, collating, and analyzing field notes.  The main source of data 

for an ethnographic thesis will be the student’s fieldnotes and any other existing documents that 

may be relevant to the research study.   
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Final requirements will be established by the committee, but it is expected that the student will 

produce roughly 100 double-spaced pages of fieldnotes, which will be submitted as an appendix 

to the thesis.  Though it is not required, students may choose to supplement ethnographic 

observation data with other types of data, such as multivariate quantitative analysis, content 

analysis of relevant documents, or in-depth interviews. 

Case Study 

For students utilizing a case study methodology, the student’s thesis committee should review 

and agree upon a somewhat focused research plan including information regarding central 

research questions, research location(s) and protocol, the boundaries of “the case,” and the 

different types of data to be collected (observation, survey administration, key informant 

interviews, document analysis, etc) along with related protocols. 

While the final research plan will be developed and agreed upon by the student and the 

committee, it is expected that students engaging in case study research will spend no fewer than 

20 hours immersed in data collection related to the case.  This does not include the time 

dedicated to writing, organizing, collating, and analyzing data.   

While we acknowledge different methods of uncovering emergent themes across this mixed 

method design, we encourage the use of some form of formalized data management software.  

Common Computer Assisted Qualitative Data Analysis (CAQDA) options include software such 

as Excel, Dedoose, N-Vivo, or Atlas-ti for managing and examining, and triangulating the 

coding schema.  Depending on the types of data collection methods utilized, surveys, interview 

or observation protocols, and/or codebooks developed would be included as an appendix to the 

thesis along with coding examples and any other appropriate means of visualizing the data 

collected. 

Content Analysis 

For students engaging in a content analysis, the student’s thesis committee should review and 

agree upon central research questions, the available data source(s) and level of analysis, as well 

as an appropriate sample size given the level of analysis and types of analytic procedures decided 

upon (for example: 5 feature films, a single 100 page policy, 12 transcribed youtube videos, 15 

transcribed episodes of a TV show, 35 song lyrics, 20 news articles and comments, etc).  Larger 

samples are appropriate when the material is brief (i.e., news articles) and the coding less 

detailed; smaller samples when the material is long and the coding more detailed. 

While the final research plan will be developed and agreed upon by the student and the 

committee, it is expected that students engaging in content analytic research will spend no fewer 

than 30 hours immersed in identifying the source material, collecting the items, preparing them 

for analysis (including any potential transcription work), developing a coding schema (which 

may emphasize qualitativeand/or quantitative aspects), and then applying the codebook to the 

data.  This expectation does not include the time dedicated to general thesis write up. 

For students conducting content analysis, we encourage the use of some kind of formalized data 

management software such as Excel, Dedoose, N-Vivo, or Atlas-ti in order to aid in analysis and 
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faculty oversight.  The appendix to the thesis would include a copy of the codebook outlining 

procedures, codes, operationalized definitions, and coded data excerpts/examples along with any 

other appropriate means of visualizing the data.  If the project includes multiple coders of the 

material, a description of how the coders were trained and how any differences in coding were 

resolved must be included.  Additionally, all source material must be appropriately cited and/or 

referenced so that an independent reviewer might easily find the data. 
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Thesis Completion Timeline 

 

 FALL semester, Year 1 

o Define area of research interest, begin to develop topic for project 

 

 SPRING semester, Year 1 

o Commit to an area of research interest and identify appropriate methodology 

o Determine major advisor and committee members 

 

 SUMMER semester 

o Compile sources for literature 

o Complete a draft of the literature review 

 

 FALL semester, Year 2 

o Prepare and analyze data for your thesis or non-thesis project 

o Complete literature review and data/ methods sections of thesis document 

o Review policies and procedures for thesis documents and defense 

 

 SPRING semester, Year 2 

o Complete data analysis for project 

o Complete remaining sections of thesis document (results and discussion sections) 

o Submit application for Degree (see Graduate School deadlines) 

o Schedule and complete Oral Defense (see Graduate School deadlines) 
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Thesis Tips for Students and Advisors 

 
Choosing an Advisor 

 Read through the Sociology faculty’s’ CVs and familiarize yourself with their areas of 

interest so that you can select someone who has experience researching your area of interest. 

 

 Look at the specific datasets each faculty member has worked with and check if that may be 

a dataset that could work with your project. 

 

 Get to know the faculty during Proseminar. Consider the personality and work habits of each 

faculty member and whether you would be a good fit. 

 

Working with your Advisor 

 Once you know who your advisor will be, email them right away to set up an initial meeting 

to talk through expectations.  

 

 Establish the best method of communication (email, text, phone calls, etc.). 

 

 Schedule weekly meetings, preferably in person, to discuss your progress, obtain feedback, 

and get guidance on next steps. 

 

 Set deadlines for thesis component drafts. Breaking the thesis into smaller tasks can make it 

more manageable and reduce anxiety. 

 

 Don’t be afraid to ask questions- the thesis can seem overwhelming but your advisor is there 

to guide you. 
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Formatting Your Thesis 

 
The Graduate School Guide to the Preparation of Theses and Dissertations provides all 

formatting requirements for your thesis. This section provides some formatting techniques in 

Microsoft Word (Versions 1997-2003, 2007 & 2010) to help in formatting your document. 

 

Tables and Figures 

Do not create tables or figures in Word, use Excel to create your tables & insert the excel 

worksheet as an object into Word. 

 

Title Page and Table of Contents 

Begin by typing in your Title page, Table of Contents, and at least your Introduction page. 

 

To place dot leaders in your Table of Contents: 

Word 1997-2003 Version 

1. On the page of your Table of Contents, choose Format from the top menu bar. 

2. Then choose Tabs. 

3. Put in the Tab stop position, normally 6.5 (this is the distance to the right that the dot 

leaders extent, normally place it at the right edge of your document, you can use the 

number from the ruler bar at the top of your document if displayed, it is the right margin 

boundary). 

4. Choose Alignment right. 

5. Choose Leader as type 2. 

6. Click OK. 

Word 2007 and 2010 Versions 

1. On the page of your Table of Contents, choose the Home menu tab & expand the 

Paragraph section. 

2. Then choose Tabs. 

3. Put in the Tab Stop Position, normally 6.5 (this is the distance to the right that the dot 

leaders extend, normally place it at the right edge of your document, you can use the 

number from the ruler bar at the top of your document if displayed, it is the right margin). 

4. Choose Alignment Right. 

5. Choose Leader as Type 2. 

6. Click OK. 

 

Now type in your chapter/section heading & then press the Tab key, this will extend the dot 

leaders over at which time you can type in your page numbers (page numbers can be inserted 

later and/or changed). 

 

  

https://www.wichita.edu/academics/graduate_school/documents/ThesisDissertationManual.pdf
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Page Numbering 

Page numbering—position at the bottom center; title page set to i, not displayed; abstract, table 

of contents, etc. set page number to start at ii, displayed at the bottom center; Introduction set 

page number to 1 & continue page numbers throughout the rest of the manuscript. 

 

Word 1997-2003 Version 

1. From the Title page, place your cursor at the top of the page. 

2. Choose Insert from the top menu bar. 

3. Select Page Number. 

4. Select Position, choose Bottom of Page. 

5. Select Alignment, choose Center. 

6. Uncheck Show number on first page. 

7. Click on Format. 

8. Select Number Format, choose the i, ii, iii option. 

9. Click OK twice. 

Word 2007 and 2010 Versions 

For the Title page and Table of Contents: 

1. From the Title page, place the cursor at the top of the page. 

2. Choose Insert from the top menu bar. 

3. Under Header & Footer, choose Page Number. 

4. Select Bottom of Page. 

5. Choose Centered (Plain Number 2) (Option 2). 

6. Click on the Design tab in the top menu bar. 

7. Under Options, choose (check) Different First Page. 

8. Click on the Design tab in the top menu bar. 

9. Under Close, click Close Header and Footer. 

10. (Instead of 8 & 9, you can also double-click within the body of the document). 

11. Choose Insert from the top menu bar. 

12. Under Header & Footer, choose Page Number. 

13. Choose Format Page Numbers. 

14. Under Number Format, choose from the drop-down menu i, ii, iii… 

15. Choose Start at: (should default to i). 

16. Click OK. 

For the Introduction and following pages: 

1. From the first page of the Introduction, place the cursor at the top of the page. 

2. Choose Page Layout from the top menu bar. 

3. Under Page Setup, choose Breaks. 

4. Choose Next Page (4th selection). 

5. Choose Insert from the top menu bar. 

6. Under Header & Footer, choose Page Number. 

7. Select Bottom of Page. 
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8. Choose Centered (Plain Number 2) (Option 2). 

9. Put your cursor at the beginning of the first page that will be numbered differently. 

10. Click on the Page Layout Tab at the top of the screen and Click Breaks. 

11. Click Continuous Break and then click OK. 

12. Click on the Insert Tab at the top of the screen and click Footer. 

13. Click Edit Footer. 

14. Select the first Footer that will be numbered differently. 

15. On the Header & Footer Tools Tab Click Page Number. 

16. Click Format Page Numbers. 

17. In the Number Format drop down box, Click the format for 1, 2, 3… 

18. Click OK. 

19. On the Header & Footer Tools Tab, Click Close on the far right. 

 

Excel Page Numbers: 

Once you have your final document done (including the title page, table of contents, copyright 

page, acknowledgements, etc.), find out what your last page number is in the Word document. 

Then open Excel and start placing page numbers on each sheet starting with the next page value 

beyond your Word document (be sure to format the font the same as the Word document). 

For worksheets in portrait orientation, choose Print Preview, Page Setup, Header/Footer tab, 

Custom Footer, and place the correct page number in the center footer box (remember to make it 

the same font as in your Word document) and then click OK twice. 

For worksheets in landscape orientation, find the center vertical cell in Column A, type in the 

correct page number (remember to make it the same font as in your Word document), then press 

CTRL-1 key sequence, Alignment tab, Alignment Grid and either move the line to the vertical 

bottom or set the degrees at -90.  
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Guidelines for Non-Thesis Options 

 

Students who choose to follow the applied (non-thesis) track must complete 6 hours of directed 

project or sociological practice internship in addition to the required coursework. Additionally, 

non-thesis track students must submit a portfolio as an additional requirement for graduation, 

which must be approved by a committee. Guidelines and requirements for directed projects, 

sociological practice internships, and the portfolio follow. 

 

Option 1: Directed Project 

 

All students pursuing a research non-thesis option will be required to hold a research planning 

meeting with their research advisor in order to outline the research plan and seek guidance and 

expectations prior to submitting IRB materials and engaging in the research process.  Students 

should schedule this research planning toward the beginning of the semester they first enroll in 

project hours (SOC 851) (usually in the Fall semester of their second year). The final document 

should include a literature review justifying the project and situating it within the larger body of 

relevant research, as well as a discussion of methods, results, limitations, implications, and 

conclusions.  

Basic Quantitative Research 

For students conducting basic research, the student and their advisor should review and agree 

upon a research plan including central research questions, preliminary hypotheses, the dataset to 

be used, and appropriate statistical techniques.  The student will then submit IRB materials 

before engaging in the research process. Students will use secondary data to facilitate timely 

completion of their project and MA degree. Datasets should come from widely accepted social 

science sources (such as ICPSR or IPUMS) and should have fairly large samples unless 

alternative arrangements have been made with the advisor. An alternative approach may be 

combining data from multiple sources into a unique dataset. Variables selected will be guided by 

a review of the relevant literature as well as data limitations, and analyses will include 

appropriate univariate, bivariate, and multivariate statistical techniques.  

Basic Qualitative Research 

The faculty encourage the use of formalized data management software when appropriate. 

Common Computer Assisted Qualitative Data Analysis (CAQDA) options include software such 

as Excel, Dedoose, N-Vivo, or Atlas-ti for managing and analyzing qualitative data. 

Interviews & Focus Group-Based Research 

For students conducting interview based research (individual or group), the student and their 

advisor should review and agree upon a research plan including central research questions, 

preliminary hypotheses, and the number and structure of the interviews or focus groups.  The 

student will then submit IRB materials before engaging in the research process. There should be 
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enough interviews or focus groups to provide for sufficient diversity and recognition of essential 

patterns in the data. Also, there should be a systematic analytical process which delineates the 

coding methodology. In order to demonstrate a thorough grasp of the data, interviews should be 

transcribed by the graduate student with faculty advisor oversight.  An interview or focus group 

protocol would be included as an appendix to the project document along with coding examples 

rather than complete transcripts of the interviews.  

Ethnographic Research 

For students conducting ethnographic research, the student and their advisor should review and 

agree upon a somewhat focused research plan including information regarding central research 

questions, research location(s) and protocol, length of time in the field, and plans for ensuring the 

safety of the student. The student will then submit IRB materials before engaging in the research 

process. The main source of data for an ethnographic project will be the student’s fieldnotes and 

any other existing documents that may be relevant to the research study. Though it is not 

required, students may choose to supplement ethnographic observation data with other types of 

data, such as quantitative analysis, content analysis of relevant documents, or in-depth 

interviews. 

Case Study 

For students utilizing a case study methodology, the student and their advisor should review and 

agree upon a somewhat focused research plan including information regarding central research 

questions, research location(s) and protocol, the boundaries of “the case,” and the different types 

of data to be collected (observation, survey administration, key informant interviews, document 

analysis, etc.) along with related protocols. The student will then submit IRB materials before 

engaging in the research process. Depending on the types of data collection methods utilized, 

surveys, interview or observation protocols, and/or codebooks developed would be included as 

an appendix to the project document along with coding examples and any other appropriate 

means of visualizing the data collected. 

Content Analysis 

For students engaging in a content analysis, the student and their advisor should review and 

agree upon central research questions, the available data source(s) and level of analysis, as well 

as an appropriate sample size given the level of analysis and types of analytic procedures decided 

upon. If appropriate, the student will then submit IRB materials before engaging in the research 

process. Larger samples are appropriate when the material is brief (i.e., news articles) and the 

coding less detailed; smaller samples when the material is long and the coding more detailed.  

The appendix to the project document would include a copy of the codebook outlining 

procedures, codes, operationalized definitions, and coded data excerpts/examples along with any 

other appropriate means of visualizing the data. (If the project includes multiple coders of the 

material, a description of how the coders were trained and how any differences in coding were 

resolved must be included.)  Additionally, all source material must be appropriately cited and/or 

referenced so that an independent reviewer might easily find the data. 
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Evaluation/Applied Research 

For students conducting evaluation or applied research for an agency or program, the student, 

their advisor, and the agency/program staff-person should review and agree upon a research plan 

including central research questions, preliminary hypotheses, the data to be used, and appropriate 

methodological and analytical techniques.  These projects may use already existing data from an 

agency or program, or data may be collected or compiled by the student.  Given that these 

projects are expected to be conducted for the purposes of the agency or program, the research 

plans are expected to have more input from the agencies or programs associated with the data 

than thesis projects.  The student will then submit IRB materials before engaging in the research 

process. The amount of data should be appropriate to the project.  Techniques and variables 

selected should be driven by the goals of the project as well as a review of the relevant literature, 

and analyses may be qualitative or quantitative.  For these types of projects, an executive 

summary, recommendations for implementation, and other documents appropriate for policy 

papers may be expected as well.  

 

Option 2: Sociological Practice Internship 

 

The Sociological Practice Internship integrates academic theory with planned professional 

experience providing students with practical skills training under academic supervision to 

complement the student’s academic program.  Individualized programs must be formulated in 

consultation with and approved by appropriate faculty sponsors as well as the Career 

Development Center. 

Students using the internship option will complete 6 hours of internship credit (SOC 781N) 

under the direction of one faculty advisor (6 credit hours equals 270 hours of work, according to 

university guidelines). In order to enroll in Internship hours, faculty advisor consent and 

registration with the College of Liberal Arts & Sciences Cooperative Education/Career 

Development Center representative are required. These hours may be with one agency, program, 

or business, or may be at a combination of agencies, programs, or businesses.  Each credit hour 

for the Sociological Practice Internship (SOC 781N) is defined as at least 45 hours of supervised 

work each semester.  

Internship Paper 

Learning objectives will be developed collaboratively with the internship/work supervisor and 

Sociology faculty advisor. As part of the final requirements, the student will compile and submit 

a paper documenting what they have learned and projects they have completed during the 6 

hours.  While the specific requirements and format of this paper will be decided upon with the 

advisor, the paper should include the following: 

 Description of the Agency/Organization: Describe the nature or purpose of the agency or 

organization as well as its relevant history or background.  
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 Description of the Internship Experience: Describe your role as an intern, including tasks 

or activities performed and key characteristics of your internship site. Explain how the 

internship experience (and/or research project) is situated within the agency or 

organization (what is the relation of your work as an intern to the program goals?).How 

did your role shape your observations or research efforts within the agency or 

organization? 

 Sociological Analysis: What is the sociological significance of your experience and 

observations within this agency or organization? Identify relevant sociological 

perspectives, theories, or concepts to understanding the agency/organization, its role or 

relationship to the surrounding community, and your role within it. Your analysis may 

have to do with interpersonal, group, organization, community, national, and/or global 

relationships, and you may want to demonstrate the relationships between these levels 

(for example, how community dynamics are shaped by national policies). This is the most 

important part of the paper. 

 Critique: Identify problem areas you experienced or observed in your internship. This 

may also include a self-evaluation of work performed. 

 Conclusion and Recommendations: Identify how problem areas may be addressed or how 

dynamics or outcomes within the agency or organization may be improved. 

Recommendations should be grounded in sociological perspectives, theories, and 

research. Finally, identify how the internship experience developed skills or professional 

goals.  

If a student completes two 3-hour internships at separate agencies or organizations, they will 

complete an Internship paper for each of those experiences.  

 

Option 3: Combined Research and Internship 

 

Under the direction and with the approval of their faculty advisor, a student may design a 

program that meets sociological and educational goals which combines an internship experience 

with a research project.  This student would take 3 research project hours (SOC 851) and 3 hours 

of internship credit (SOC 781N) under the direction of one faculty advisor. If appropriate, the 

student will submit IRB materials before engaging in the research process. Guidelines outlined 

above for directed projects and internship options should be followed for each 3 hour experience.  
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Guidelines for Completing the Portfolio Requirement 
 

For completion of the non-thesis MA degree, students must compile and submit an extensive 

portfolio documenting what they have learned and projects they have completed during the 6 

hours.   

Format 

Portfolios can also be organized in paper format or electronic format, using “WordPress” or 

other appropriate electronic applications. Specific format requirements will be decided upon with 

the advisor. A final electronic copy of the portfolio should be sent to the graduate coordinator 

once approved.  

Contents 

The portfolio should include the following items: 

 Cover page 

 Table of Contents 

 CV or Resume 

 Program Reflection Statement  

This statement should include the following: 

o Reflect on your career goals  

o Identify specific skills or knowledge developed during program 

o Connect your work or research experiences with your knowledge 

o Describe your intellectual and personal growth 

 Papers from directed project or internship 

o Internship papers from each internship 

o One final directed project document (unless 2 separate projects, then report for 

each) 

 Beyond these required elements, you may include additional pieces as suggested by your 

chair: 

o Presentations (slides) 

o Reports or articles  

o Materials developed (teaching materials, reports, brochures) 

o Evaluations from internship supervisors 
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Timeline for Completing the Non-Thesis Requirements 

Students will form a portfolio committee toward the beginning of the semester they first enroll in 

project hours (SOC 851) or sociological practice internship (SOC 781N) (usually in the Fall 

semester of their second year). The committee should include a chair (ideally the advisor for the 

directed project or internship) and a reader (another graduate faculty member from the Sociology 

Department or a graduate faculty member from another department with relative expertise). 

Students should schedule regular meetings with their committee chair in order to ensure progress 

is being made on the portfolio and expectations are clear.  

Complete portfolios should be submitted no less than 2 weeks before the last day of classes in 

that semester to the committee to review and approve. This allows time for revisions if 

necessary. A final version of the portfolio must be approved by the end of the semester in order 

to meet requirements for graduation.  
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Important Links from Graduate School 
 

Make sure to familiarize yourself with Graduate School policies and deadlines.  

 The Graduate School website can be found here  

 The Graduate Catalog can be found here 

 The graduation deadlines can be found here 

 The complete guide for thesis formatting can be found here 
  

https://www.wichita.edu/academics/gradschool/DegreeCompletion/Deadlines.php
http://catalog.wichita.edu/graduate/
https://www.wichita.edu/academics/gradschool/documents/GraduationDeadlines.pdf
https://www.wichita.edu/academics/graduate_school/documents/ThesisDissertationManual.pdf
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Graduate Assistantships: 
 

The department offers a limited number of Graduate Assistantships (GA) each year on a 

competitive basis.  These awards are made through funding provided by the Graduate School and 

the Fairmount College of Liberal Arts and Sciences. These positions serve as apprenticeships for 

teaching and/or research in sociology.  GTAs are provided a monthly stipend and a partial tuition 

waiver of up to 75% and a 10% discount on books purchased for classes.  Each GTA is assigned 

to one or more faculty members and given office space and other university privileges.  

Throughout their tenure as a GTA, each person can be assigned to various faculty members to 

assist in their teaching and research. This is meant to give exposure to various faculty styles of 

teaching and research activities.  Depending on the courses taught and the interest of the GTA, 

faculty members are encouraged to allow their GTA to give one or more guest lectures.  Faculty 

members are also encouraged to monitor student lectures and grading and to provide constructive 

feedback to the student. 

GTA Application Process and Terms of Re-Appointment: 

Students who wish to apply for a GTA must submit an application to the Graduate Coordinator 

by the priority deadline (March 1st).  This application may be found on the Graduate School 

website. The number of GTA positions offered depends on available funding (approximately 8 

positions have been available each year in recent years). The selection process is competitive and 

award decisions are made by the Sociology Graduate Admissions Committee each Spring for the 

following academic year.  The following criteria are utilized for the awarding of GTA positions: 

 GPA (undergraduate or current graduate coursework) 

 Background and coursework in Sociology 

 Strength of recommendation letters 

 Ability to perform the duties of a GTA and meet the needs of faculty in the areas of 

teaching and research 

 Review of other admission application materials (such as the personal statement) 

 

Graduate Students who have been awarded a GTA position may re-apply when the terms of their 

current GTA position expires by submitting an application by March 1st. (NOTE: There is a four-

semester limit on GTA positions per student).  The following criteria are utilized for awarding 

GTA positions to current students: 

 GPA of 3.00 or higher 

 Satisfactory progress toward degree completion 

 Satisfactory recommendations from supervising faculty 

 Continuing ability to perform the duties of a GTA and meet the needs of faculty in the 

areas of teaching and research 

 

  

https://www.wichita.edu/academics/gradschool/documents/Asstappl.pdf
https://www.wichita.edu/academics/gradschool/documents/Asstappl.pdf
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Duties and Responsibilities 

 

Duties and responsibilities will vary depending on the faculty members to whom the GTA is 

assigned.  In general, GTAs are expected to become familiar with the Sociology department and 

its resources in order to assist students and faculty with research and academic functions.  GTAs 

also are expected to rotate with other GTAs in coverage of the department office if necessary 

throughout the semester.  The duties and responsibilities GTAs may be expected to perform are: 

 attend lectures of the faculty member they are assisting 

 design, administer, and grade exams and homework assignments 

 prepare and present classroom lectures 

 hold office hours to meet with students regarding lecture/exam information 

 develop bibliographies for faculty or office resources 

 assist faculty through campus library research for classes, presentations, and research 

 assist in curriculum development and evaluation 

 provide support to the department (office coverage, tabling at events, etc) 

 assist with departmental projects (such as developing recruitment materials or assembling 

information regarding the job market, PhD programs, etc) 

 

GTAs are prohibited from grading coursework of their graduate student peers. 

General information about graduate assistantships and Graduate School policies will be covered 

in a mandatory GTA workshop each year. Please see the Graduate School’s University 

Assistantship Policies for more information.  

 

Hours 

 

GTAs are expected to work a set number of hours per week (i.e., 10, 15, 20) for the entire 

semester.  The number of hours to be worked will be outlined in the contract for employment.  In 

general, GTAs will find that some weeks you will put in all your assigned hours, other weeks 

you will put in less.  The Graduate School forbids GTAs from putting in more hours than what 

they are assigned.  All GTAs are expected to keep a ledger of their hours and duties to be 

submitted to the Graduate Coordinator on a weekly basis. 

 

https://www.wichita.edu/academics/gradschool/FinancialAssistance/assistantships.php
https://www.wichita.edu/academics/gradschool/FinancialAssistance/assistantships.php
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	Greetings from the Graduate Coordinator 
	 
	On behalf of the Department of Sociology, welcome to the Sociology MA Program! This handbook provides information for current and potential students about our graduate program, including admissions, requirements, thesis and non-thesis projects, internships, and assistantships.  We also include some guidance for how to navigate the program and the thesis project. As Graduate Coordinator, I am responsible for screening applicants for admission, recruiting new students, advising students, assigning Graduate As
	 
	Our Sociology MA program offers a structured two-year series of courses that provide a strong foundation in sociological theory, research methods, and statistics. The Sociology Department at WSU emphasizes a social justice perspective, and our students develop insights about the effects of social structures on individual lives and communities.  For example, our faculty research focuses on issues such as teen dating violence, sexual minority well-being, runaway youth, gentrification, educational policy, and 
	 
	The Department of Sociology offers a Master of Arts degree with both a thesis and non-thesis option, and you will find information about both below. Given the structure course of study in our program, courses usually must be completed in a specific order. Each of these required courses provides foundational research skills in theory, methodology and statistics, and they prepare students for independent research (thesis project) or applied settings (internship).  
	If you have any questions, you may contact me through any of the methods below: 
	 
	Dr. Jennifer Pearson, Graduate Coordinator 
	Pronouns: She/Her/Hers 
	Department of Sociology 
	Wichita State University 
	1845 Fairmount, Campus Box 25 
	Wichita, KS 67260-0025 
	 
	Email: 
	Email: 
	jennifer.pearson@wichita.edu
	jennifer.pearson@wichita.edu

	  

	Phone: (316)978-7145  
	Graduate Faculty and Areas of Specialization  
	Full-Time Faculty 
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	Span
	Chase M. Billingham
	Chase M. Billingham

	 (Ph.D., Northeastern University). Assistant Professor. Urban sociology, education, racial stratification, public policy, quantitative methods. 

	 
	P
	Span
	Contact: 
	chase.billingham@wichita.edu
	chase.billingham@wichita.edu

	, 316-978-7144 

	 
	P
	Span
	Jodie L. Hertzog
	Jodie L. Hertzog

	 (Ph.D., Purdue University). Department Chair and Undergraduate Program Coordinator.  Associate Professor. Family & Intimate Relationships, Gender, Intimate Partner Violence Prevention, Work-Family Interfaces.  

	 
	P
	Span
	Contact: 
	jodie.hertzog@wichita.edu
	jodie.hertzog@wichita.edu

	, (316) 978-7155 

	 
	P
	Span
	Twyla J. Hill
	Twyla J. Hill

	 (Ph.D., University of California-Irvine). Professor. Sociology of Aging, Sociology of Families, Sociology of Law, Research Methods. 

	 
	P
	Span
	Contact: 
	twyla.hill@wichita.edu
	twyla.hill@wichita.edu

	, (316) 978-7151 

	 
	P
	Span
	Charles S. Koeber
	Charles S. Koeber

	 (Ph.D., State University of New York, Binghamton).  Associate Professor. Job Loss, Work, Labor Process, Labor Markets, Stratification/Inequality, Consumption. 

	 
	P
	Span
	Contact: 
	chuck.koeber@wichita.edu
	chuck.koeber@wichita.edu

	, 316) 978-7147 

	 
	P
	Span
	Jennifer Pearson
	Jennifer Pearson

	 (Ph.D., University of Texas at Austin). Graduate Coordinator. Associate Professor. Gender and Sexualities, Education, Adolescence and the Transition to Adulthood. 

	 
	P
	Span
	Contact: 
	jennifer.pearson@wichita.edu
	jennifer.pearson@wichita.edu

	, (316) 978-7145 

	 
	P
	Span
	Kathleen M. O'Flaherty Perez
	Kathleen M. O'Flaherty Perez

	 (Ph.D., Purdue University). Associate Professor. Research Methods, Urban, Demography. 

	 
	P
	Span
	Contact: 
	kathy.perez@wichita.edu
	kathy.perez@wichita.edu

	, (316) 978-7152 

	 
	P
	Span
	Lisa Thrane
	Lisa Thrane

	 (Ph. D., Iowa State University). Associate Professor. Deviance, Mental Health, Homeless and Runaway Youth, Research Methods. 

	 
	P
	Span
	Contact: 
	lisa.thrane@wichita.edu
	lisa.thrane@wichita.edu

	, (316) 978-7150 

	Full-Time Teaching Faculty 
	 
	Jodie Simon (MA, Wichita State University).  Associate Teaching Educator.  
	Contact: 
	Contact: 
	jodie.simon@wichita.edu
	jodie.simon@wichita.edu

	. 

	Shirlene Small (MA, Wichita State University). Associate Teaching Educator. 
	Contact: 
	Contact: 
	shirlene.small@wichita.edu
	shirlene.small@wichita.edu

	. 

	 
	Part-time Lecturers 
	 
	Deborah Beat (MA, Wichita State University). 
	 
	Eunita Jackson (MA, Emporia State University). 
	 
	Tisha Whitehead (MA, Wichita State University). 
	 
	Other Affiliated Faculty 
	 
	Ronald R. Matson (Ph.D., University of Colorado).  Emeritis Professor. Gender Studies, Masculinity, Intimate Relationships, Parenting. 
	Mark Vermillion (Ph.D. Oklahoma State University).  Department of Sports Management, Chair & Associate Professor. 
	David W. Wright (Ph.D., Purdue University). Associate Vice President for Academic Data Systems and Strategic Planning & Professor. Stratification and Class Analysis, Marxism, Employment and Income, Theory, Graduate Data Management and Statistics.  
	Application Process 
	 
	Graduate School Application and Requirements: 
	Students who wish to pursue graduate education in the department of Sociology must first apply to the WSU Graduate School 
	Students who wish to pursue graduate education in the department of Sociology must first apply to the WSU Graduate School 
	online
	online

	. This application is then forwarded to and screened by the graduate coordinator in the department of Sociology. Each applicant must submit official transcripts of all previous academic work, including credits earned at community colleges or work transferred to another institution. Instructions for how to submit official transcripts are provided in the 
	Admission
	Admission

	 section of the WSU Online Graduate Catalog.  

	The minimum Graduate School requirements are: 
	 Bachelor’s degree from a regionally accredited institution or a recognized institution in another country whose requirements for the bachelor’s degree are substantially equivalent to a U.S. bachelor’s degree. 
	 Bachelor’s degree from a regionally accredited institution or a recognized institution in another country whose requirements for the bachelor’s degree are substantially equivalent to a U.S. bachelor’s degree. 
	 Bachelor’s degree from a regionally accredited institution or a recognized institution in another country whose requirements for the bachelor’s degree are substantially equivalent to a U.S. bachelor’s degree. 

	 Grade point average of at least 2.750, including any post bachelor’s graduate work 
	 Grade point average of at least 2.750, including any post bachelor’s graduate work 

	 No more than 9 credit hours of background deficiencies in the desired field of graduate study. 
	 No more than 9 credit hours of background deficiencies in the desired field of graduate study. 

	 Proof of English proficiency may be required for U.S. citizens or permanent residents who are non-native English speakers. The International Applicants section of the 
	 Proof of English proficiency may be required for U.S. citizens or permanent residents who are non-native English speakers. The International Applicants section of the 
	 Proof of English proficiency may be required for U.S. citizens or permanent residents who are non-native English speakers. The International Applicants section of the 
	Graduate Catalog
	Graduate Catalog

	 provides more information about these requirements. 



	 
	The Graduate School offers two admission statuses, degree and nondegree, to accommodate qualified students desiring to pursue graduate degrees as well as those simply desiring to earn graduate credit for personal and professional reasons. See the 
	The Graduate School offers two admission statuses, degree and nondegree, to accommodate qualified students desiring to pursue graduate degrees as well as those simply desiring to earn graduate credit for personal and professional reasons. See the 
	Admission Requirements
	Admission Requirements

	 section of the WSU Online Graduate Catalog for more complete information on the above requirements and the degree level options. 

	Department of Sociology Graduate Admission Requirements: 
	In addition to the Graduate School requirements for admission, the Department of Sociology requires: 
	 Overall grade point average (GPA) of at least 3.00 
	 Overall grade point average (GPA) of at least 3.00 
	 Overall grade point average (GPA) of at least 3.00 

	 One college algebra course 
	 One college algebra course 

	 At least 12 hours in social science courses including: 
	 At least 12 hours in social science courses including: 

	o an introductory sociology course 
	o an introductory sociology course 
	o an introductory sociology course 

	o one social statistics course 
	o one social statistics course 

	o one research methods course, and 
	o one research methods course, and 

	o one theory course 
	o one theory course 



	Students without these required courses in social statistics and/or theory may be admitted provisionally, but deficiencies must be removed in the first year of graduate study.  
	 Three letters of reference from professors who are familiar with the student's academic course work 
	 Three letters of reference from professors who are familiar with the student's academic course work 
	 Three letters of reference from professors who are familiar with the student's academic course work 

	 A typed, double-spaced statement of purpose (approximately 500 words) articulating the student's area of research interests and academic/career goals. 
	 A typed, double-spaced statement of purpose (approximately 500 words) articulating the student's area of research interests and academic/career goals. 


	 
	Graduate Degree Options and Requirements: 
	 
	The department offers both a thesis and non-thesis option.  Unique among most graduate programs, the thesis and non-thesis options in the Department of Sociology are similar in required course work, level of difficulty, content and written structure. Both options require the completion of an individual research project and submission of a final document (see expectations and requirements below). The primary difference between the two options is that the thesis option requires you to form a thesis committee 
	Thesis Option: Students in the thesis program must complete a total of 32 credit hours, including: 
	SOC 860 
	SOC 860 
	SOC 860 
	SOC 860 

	Proseminar 
	Proseminar 

	3 
	3 

	Span

	SOC 811 
	SOC 811 
	SOC 811 

	Advanced Research: Quantitative Methods 
	Advanced Research: Quantitative Methods 

	3 
	3 

	Span

	SOC 812 
	SOC 812 
	SOC 812 

	Advanced Research: Qualitative Methods 
	Advanced Research: Qualitative Methods 

	3 
	3 

	Span

	SOC 845 
	SOC 845 
	SOC 845 

	Seminar in Sociological Theory 
	Seminar in Sociological Theory 

	3 
	3 

	Span

	SOC 875/876 
	SOC 875/876 
	SOC 875/876 

	Thesis Hours 
	Thesis Hours 

	6 
	6 

	Span

	 
	 
	 

	800-level seminar 
	800-level seminar 

	3 
	3 

	Span

	 
	 
	 

	Electives (or prerequisites if required) 500-level or above 
	Electives (or prerequisites if required) 500-level or above 

	11 
	11 

	Span

	Total 
	Total 
	Total 

	32 
	32 

	Span


	 
	Non-Thesis Option: The non-thesis program allows more flexibility in required coursework (with Graduate Coordinator approval) but with a total of 32 credit hours. Expectations for this coursework include: 
	SOC 860 
	SOC 860 
	SOC 860 
	SOC 860 

	Proseminar 
	Proseminar 

	3 
	3 

	Span

	SOC 811 
	SOC 811 
	SOC 811 

	Advanced Research: Quantitative Methods 
	Advanced Research: Quantitative Methods 

	3 
	3 

	Span

	SOC 812 
	SOC 812 
	SOC 812 

	Advanced Research: Qualitative Methods 
	Advanced Research: Qualitative Methods 

	3 
	3 

	Span

	SOC 845 
	SOC 845 
	SOC 845 

	Seminar in Sociological Theory 
	Seminar in Sociological Theory 

	3 
	3 

	Span

	SOC 851/SOC 781N 
	SOC 851/SOC 781N 
	SOC 851/SOC 781N 

	Project Hours or Internship Hours 
	Project Hours or Internship Hours 

	6 
	6 

	Span

	 
	 
	 

	One 800-level seminar 
	One 800-level seminar 

	3 
	3 

	Span

	 
	 
	 

	Electives (or prerequisites if required) 500-level or above 
	Electives (or prerequisites if required) 500-level or above 

	11 
	11 

	Span

	Total 
	Total 
	Total 

	32 
	32 

	Span


	 
	Dismissal and Transfer to Non-Degree Status: 
	A Sociology graduate student may be dismissed from the program for any of the following reasons: 
	 student's GPA drops below 2.00 
	 student's GPA drops below 2.00 
	 student's GPA drops below 2.00 

	 student does not make satisfactory progress toward degree completion 
	 student does not make satisfactory progress toward degree completion 

	 student enters the program on probationary status and fails to achieve a cumulative GPA of 3.00 after nine hours of course work 
	 student enters the program on probationary status and fails to achieve a cumulative GPA of 3.00 after nine hours of course work 

	 student is placed on probation and fails to achieve a cumulative GPA of 3.00 after nine hours of course work 
	 student is placed on probation and fails to achieve a cumulative GPA of 3.00 after nine hours of course work 

	 student violates the 
	 student violates the 
	 student violates the 
	Student Code of Conduct
	Student Code of Conduct

	 as outlined in the WSU Policies and Procedures Manual 



	 
	A Sociology graduate student in full-standing may be transferred to non-degree status for any of the following reasons: 
	 student does not enroll in any sociology course work for more than 12 months 
	 student does not enroll in any sociology course work for more than 12 months 
	 student does not enroll in any sociology course work for more than 12 months 

	 student fails to enroll within 12 months after admission into the program 
	 student fails to enroll within 12 months after admission into the program 

	 student fails to receive consent of the instructor for any Independent/Directed Study course 
	 student fails to receive consent of the instructor for any Independent/Directed Study course 

	 student fails to receive their advisor's expressed approval for course enrollment 
	 student fails to receive their advisor's expressed approval for course enrollment 

	 student does not exhibit satisfactory progress in their program as evidenced by low GPA (under 3.00), excessive incompletes, insufficient class attendance, and/or failure to meet the six year completion limit 
	 student does not exhibit satisfactory progress in their program as evidenced by low GPA (under 3.00), excessive incompletes, insufficient class attendance, and/or failure to meet the six year completion limit 


	 
	Required Coursework 
	 
	The core courses of the Sociology graduate curriculum should generally be taken in the following order: 
	SOC 860.  Proseminar - Sociology (3). Examines the academic roles of sociologists, the fields of study and types of research. Usually offered fall semester only. Fulfills the university's professional and scholarly integrity training requirement covering research misconduct, publication practices and responsible authorship, conflict of interest and commitment, ethical issues in data acquisition, management, sharing and ownership. Prerequisite: departmental consent. 
	SOC 812.  Advanced Research: Qualitative Methods (3). Graduate students deepen their understanding of the research process as they are introduced to qualitative methods, methodology and analysis. Students learn to address methodological issues by developing a pilot project requiring them to apply their understanding of qualitative methods, sampling and coding. Through this process, students are prepared to compare the strengths and limitations of quantitative, qualitative and mixed method approaches while b
	SOC 845.  Seminar in Sociological Theory   (3). A comprehensive survey of contemporary sociological theories and their classical roots. Emphasis on theories applicable to students' thesis and nonthesis projects. Generally offered spring semester only. Prerequisite: departmental consent. 
	SOC 811.  Advanced Research: Quantitative Methods   (3). Seminar course designed to provide graduate students with the conceptual tools and methodological skills needed to conduct quantitative sociological research. Students are introduced to sampling, measurement and data management issues. In addition, students gain experience with statistical software packages using large-scale data sets. Prerequisite: departmental consent. 
	Students will take one of the following in their 3rd semester: 
	SOC 875.  Thesis   (1-3). Thesis preparation. 
	Or 
	SOC 851.  Directed Project   (1-3). A project conducted under the supervision of an academic adviser for the nonthesis option. Requires the completion of a written report and an oral presentation of the research to the faculty. Prerequisite: consent of academic adviser. 
	Or 
	SOC 781N.  Sociological Practice Internship   (1-3). Integrates academic theory with planned professional experience providing students with practical skills training under academic supervision to complement the student’s academic program. Individualized programs must be formulated in consultation with, and approved by, appropriate faculty sponsors as well as the Career Development Center. Repeatable for credit. Graded Cr/NCr. 
	Students will take one of the following in their 4th semester: 
	SOC 876.  Thesis   (1-3). Thesis preparation. 
	Or 
	SOC 851.  Directed Project   (1-3). A project conducted under the supervision of an academic adviser for the nonthesis option. Requires the completion of a written report and an oral presentation of the research to the faculty. Prerequisite: consent of academic adviser. 
	Or 
	SOC 781N.  Sociological Practice Internship   (1-3). Integrates academic theory with planned professional experience providing students with practical skills training under academic supervision to complement the student’s academic program. Individualized programs must be formulated in consultation with, and approved by, appropriate faculty sponsors as well as the Career Development Center. Repeatable for credit. Graded Cr/NCr. 
	  
	Course Sequencing 
	 
	Below is the typical sequencing of courses. 60% of hours must be 700 or above.  Full time enrollment is 9 credit hours a semester. 
	Fall Year 1 (1st semester) 
	Fall Year 1 (1st semester) 
	Fall Year 1 (1st semester) 
	Fall Year 1 (1st semester) 
	i. Proseminar (860) - 3 credit 
	i. Proseminar (860) - 3 credit 
	i. Proseminar (860) - 3 credit 

	ii. Qualitative Methods course (812) – 3 credit  
	ii. Qualitative Methods course (812) – 3 credit  

	iii. Elective Or Statistics (713) - 3 credit 
	iii. Elective Or Statistics (713) - 3 credit 


	 

	Spring Year 1 (2nd  semester) 
	Spring Year 1 (2nd  semester) 
	i. Theory (845) -3 credit 
	i. Theory (845) -3 credit 
	i. Theory (845) -3 credit 

	ii. Quantitative Methods course (811) - 3 credit 
	ii. Quantitative Methods course (811) - 3 credit 

	iii. Elective Or Theory (711) - 3 credit  
	iii. Elective Or Theory (711) - 3 credit  


	 

	Span

	Fall Year 2 (3rd semester) 
	Fall Year 2 (3rd semester) 
	Fall Year 2 (3rd semester) 
	i. Thesis hours (875) -3 credit  
	i. Thesis hours (875) -3 credit  
	i. Thesis hours (875) -3 credit  


	Or 
	Directed research (851) -3 credit  
	Or 
	Sociological Internship (781N) 
	ii. Elective 
	ii. Elective 
	ii. Elective 

	iii. Elective 
	iii. Elective 


	 

	Spring Year 2 (4th semester ) 
	Spring Year 2 (4th semester ) 
	i. Thesis hours (876) -3 credit  
	i. Thesis hours (876) -3 credit  
	i. Thesis hours (876) -3 credit  


	Or 
	Directed research (851) -3 credit  
	Or 
	Sociological Internship (781N) 
	ii. 1 or more Electives 
	ii. 1 or more Electives 
	ii. 1 or more Electives 


	 

	Span


	  
	Thesis Structure and Requirements 
	 
	All students pursuing a thesis option will be required to hold a research planning meeting with all members of their thesis committee in order to outline the research plan with members, seek guidance and potential design expectations, and obtain committee approval prior to submitting IRB materials and engaging in the research process.  Students should schedule this research planning toward the beginning of the semester they first enroll in thesis hours (usually in the Fall semester of their second year).  
	The final thesis should include an extensive literature review justifying the project and situating it within the larger body of relevant research, as well as a comprehensive discussion of methods, results, limitations, implications, and conclusions.  
	Below are some general guidelines for quantitative and qualitative thesis projects.  
	 
	  
	Guidelines for Quantitative Thesis Options 
	 
	As a means of clarifying general expectations for the quantitative research option, general parameters for different types of quantitative projects were developed by the quantitative research subcommittee.  
	Basic Research 
	For students conducting basic research, the student and their major advisor should review and agree upon a research plan including central research questions, preliminary hypotheses, the dataset to be used, and appropriate statistical techniques.  This research plan will then be presented to the student’s thesis committee for approval before submitting IRB materials and engaging in the research process.  
	Students will use secondary data to facilitate timely completion of their thesis project and MA degree. Datasets should come from widely accepted social science sources (such as ICPSR or IPUMS) and should have large samples, such as those that would be publishable in peer-reviewed academic journals. An alternative approach may be combining data from multiple sources into a unique dataset.  
	Variables selected will be guided by a review of the relevant literature as well as data limitations, and analyses will include appropriate univariate, bivariate, and multivariate statistical techniques. The quality of analysis and presentation of findings should be similar to a typical social science journal article.  
	Evaluation/Applied Research 
	For students conducting evaluation or applied research, the student and their major advisor should review and agree upon a research plan including central research questions, preliminary hypotheses, the data to be used, and appropriate statistical techniques.  These projects may use already existing data from an agency or program, or quantitative data may be collected or compiled by the student.  Given that these projects may have more variation in substance and form than basic research, research plans may 
	The amount of data should be appropriate to the project. Variables selected should be driven by the goals of the project as well as a review of the relevant literature, and analyses will include appropriate univariate and bivariate statistical tests.  Multivariate analyses also may be suitable, depending on the project.  For these types of projects, an executive summary, recommendations for implementation, and other documents appropriate for policy papers may be expected as well.  
	 
	  
	Guidelines for Qualitative Thesis Options 
	 
	Given the emergent and potentially unique parameters of qualitative research projects, the Qualitative Research subcommittee proposes that students conducting a qualitative thesis option be required to hold a research planning meeting with all members of their thesis committee in order to outline the research plan with members, seek guidance and potential design expectations, and committee approval prior to submitting IRB materials and engaging in the research process.   
	Interviews & Focus Group-Based Research 
	We recommend these guidelines for interviews which provide parameters for data collection techniques, analytical process, and documentation.  
	For students conducting interview based research (individual or group), the subcommittee recommends no fewer than ten semi-structured, 1 hour, in-depth interviews to provide for sufficient diversity and recognition of essential patterns in the data.  We determined that there should be a systematic analytical process that delineated the coding methodology. While we acknowledge different methods of uncovering emergent themes, we encourage the use of formalized data management software.  Common Computer Assist
	The subcommittee also established a parallel structure for the evaluation of focus group or other forms of group interviews with the recommendation that at least two semi-structured 1-hour focus groups with no less than five persons per session would be equivalent. All other interview guidelines would remain the same with the exception that an abridged version of the transcript would excise tangential discussion not linked to the research question and make it easier for analysis.   
	Ethnographic Research 
	For students conducting ethnographic research, the student’s thesis committee should review and agree upon a somewhat focused research plan including information regarding central research questions, research location(s) and protocol, length of time in the field, and plans for ensuring the safety of the student. 
	While the final research plan will be developed and agreed upon by the student and the committee, it is expected that students engaging in ethnographic research will spend no fewer than 20 hours in the field conducting direct observation.  This does not include the time dedicated to writing, organizing, collating, and analyzing field notes.  The main source of data for an ethnographic thesis will be the student’s fieldnotes and any other existing documents that may be relevant to the research study.   
	Final requirements will be established by the committee, but it is expected that the student will produce roughly 100 double-spaced pages of fieldnotes, which will be submitted as an appendix to the thesis.  Though it is not required, students may choose to supplement ethnographic observation data with other types of data, such as multivariate quantitative analysis, content analysis of relevant documents, or in-depth interviews. 
	Case Study 
	For students utilizing a case study methodology, the student’s thesis committee should review and agree upon a somewhat focused research plan including information regarding central research questions, research location(s) and protocol, the boundaries of “the case,” and the different types of data to be collected (observation, survey administration, key informant interviews, document analysis, etc) along with related protocols. 
	While the final research plan will be developed and agreed upon by the student and the committee, it is expected that students engaging in case study research will spend no fewer than 20 hours immersed in data collection related to the case.  This does not include the time dedicated to writing, organizing, collating, and analyzing data.   
	While we acknowledge different methods of uncovering emergent themes across this mixed method design, we encourage the use of some form of formalized data management software.  Common Computer Assisted Qualitative Data Analysis (CAQDA) options include software such as Excel, Dedoose, N-Vivo, or Atlas-ti for managing and examining, and triangulating the coding schema.  Depending on the types of data collection methods utilized, surveys, interview or observation protocols, and/or codebooks developed would be 
	Content Analysis 
	For students engaging in a content analysis, the student’s thesis committee should review and agree upon central research questions, the available data source(s) and level of analysis, as well as an appropriate sample size given the level of analysis and types of analytic procedures decided upon (for example: 5 feature films, a single 100 page policy, 12 transcribed youtube videos, 15 transcribed episodes of a TV show, 35 song lyrics, 20 news articles and comments, etc).  Larger samples are appropriate when
	While the final research plan will be developed and agreed upon by the student and the committee, it is expected that students engaging in content analytic research will spend no fewer than 30 hours immersed in identifying the source material, collecting the items, preparing them for analysis (including any potential transcription work), developing a coding schema (which may emphasize qualitativeand/or quantitative aspects), and then applying the codebook to the data.  This expectation does not include the 
	For students conducting content analysis, we encourage the use of some kind of formalized data management software such as Excel, Dedoose, N-Vivo, or Atlas-ti in order to aid in analysis and 
	faculty oversight.  The appendix to the thesis would include a copy of the codebook outlining procedures, codes, operationalized definitions, and coded data excerpts/examples along with any other appropriate means of visualizing the data.  If the project includes multiple coders of the material, a description of how the coders were trained and how any differences in coding were resolved must be included.  Additionally, all source material must be appropriately cited and/or referenced so that an independent 
	  
	Thesis Completion Timeline 
	 
	 FALL semester, Year 1 
	 FALL semester, Year 1 
	 FALL semester, Year 1 

	o Define area of research interest, begin to develop topic for project  
	o Define area of research interest, begin to develop topic for project  
	o Define area of research interest, begin to develop topic for project  


	 SPRING semester, Year 1 
	 SPRING semester, Year 1 

	o Commit to an area of research interest and identify appropriate methodology 
	o Commit to an area of research interest and identify appropriate methodology 
	o Commit to an area of research interest and identify appropriate methodology 

	o Determine major advisor and committee members  
	o Determine major advisor and committee members  


	 SUMMER semester 
	 SUMMER semester 

	o Compile sources for literature 
	o Compile sources for literature 
	o Compile sources for literature 

	o Complete a draft of the literature review  
	o Complete a draft of the literature review  


	 FALL semester, Year 2 
	 FALL semester, Year 2 

	o Prepare and analyze data for your thesis or non-thesis project 
	o Prepare and analyze data for your thesis or non-thesis project 
	o Prepare and analyze data for your thesis or non-thesis project 

	o Complete literature review and data/ methods sections of thesis document 
	o Complete literature review and data/ methods sections of thesis document 

	o Review policies and procedures for thesis documents and defense 
	o Review policies and procedures for thesis documents and defense 



	 
	 SPRING semester, Year 2 
	 SPRING semester, Year 2 
	 SPRING semester, Year 2 

	o Complete data analysis for project 
	o Complete data analysis for project 
	o Complete data analysis for project 

	o Complete remaining sections of thesis document (results and discussion sections) 
	o Complete remaining sections of thesis document (results and discussion sections) 

	o Submit application for Degree (see Graduate School deadlines) 
	o Submit application for Degree (see Graduate School deadlines) 

	o Schedule and complete Oral Defense (see Graduate School deadlines) 
	o Schedule and complete Oral Defense (see Graduate School deadlines) 



	  
	Thesis Tips for Students and Advisors 
	 
	Choosing an Advisor 
	 Read through the Sociology faculty’s’ CVs and familiarize yourself with their areas of interest so that you can select someone who has experience researching your area of interest. 
	 Read through the Sociology faculty’s’ CVs and familiarize yourself with their areas of interest so that you can select someone who has experience researching your area of interest. 
	 Read through the Sociology faculty’s’ CVs and familiarize yourself with their areas of interest so that you can select someone who has experience researching your area of interest. 


	 
	 Look at the specific datasets each faculty member has worked with and check if that may be a dataset that could work with your project.  
	 Look at the specific datasets each faculty member has worked with and check if that may be a dataset that could work with your project.  
	 Look at the specific datasets each faculty member has worked with and check if that may be a dataset that could work with your project.  

	 Get to know the faculty during Proseminar. Consider the personality and work habits of each faculty member and whether you would be a good fit. 
	 Get to know the faculty during Proseminar. Consider the personality and work habits of each faculty member and whether you would be a good fit. 


	 
	Working with your Advisor 
	 Once you know who your advisor will be, email them right away to set up an initial meeting to talk through expectations.   
	 Once you know who your advisor will be, email them right away to set up an initial meeting to talk through expectations.   
	 Once you know who your advisor will be, email them right away to set up an initial meeting to talk through expectations.   

	 Establish the best method of communication (email, text, phone calls, etc.).  
	 Establish the best method of communication (email, text, phone calls, etc.).  

	 Schedule weekly meetings, preferably in person, to discuss your progress, obtain feedback, and get guidance on next steps.  
	 Schedule weekly meetings, preferably in person, to discuss your progress, obtain feedback, and get guidance on next steps.  

	 Set deadlines for thesis component drafts. Breaking the thesis into smaller tasks can make it more manageable and reduce anxiety.  
	 Set deadlines for thesis component drafts. Breaking the thesis into smaller tasks can make it more manageable and reduce anxiety.  

	 Don’t be afraid to ask questions- the thesis can seem overwhelming but your advisor is there to guide you. 
	 Don’t be afraid to ask questions- the thesis can seem overwhelming but your advisor is there to guide you. 


	 
	 
	 
	 
	 
	 
	  
	Formatting Your Thesis 
	 
	The 
	The 
	Graduate School Guide to the Preparation of Theses and Dissertations
	Graduate School Guide to the Preparation of Theses and Dissertations

	 provides all formatting requirements for your thesis. This section provides some formatting techniques in Microsoft Word (Versions 1997-2003, 2007 & 2010) to help in formatting your document. 

	 
	Tables and Figures 
	Do not create tables or figures in Word, use Excel to create your tables & insert the excel worksheet as an object into Word. 
	 
	Title Page and Table of Contents 
	Begin by typing in your Title page, Table of Contents, and at least your Introduction page. 
	 
	To place dot leaders in your Table of Contents: 
	Word 1997-2003 Version 
	1. On the page of your Table of Contents, choose Format from the top menu bar. 
	1. On the page of your Table of Contents, choose Format from the top menu bar. 
	1. On the page of your Table of Contents, choose Format from the top menu bar. 

	2. Then choose Tabs. 
	2. Then choose Tabs. 

	3. Put in the Tab stop position, normally 6.5 (this is the distance to the right that the dot leaders extent, normally place it at the right edge of your document, you can use the number from the ruler bar at the top of your document if displayed, it is the right margin boundary). 
	3. Put in the Tab stop position, normally 6.5 (this is the distance to the right that the dot leaders extent, normally place it at the right edge of your document, you can use the number from the ruler bar at the top of your document if displayed, it is the right margin boundary). 

	4. Choose Alignment right. 
	4. Choose Alignment right. 

	5. Choose Leader as type 2. 
	5. Choose Leader as type 2. 

	6. Click OK. 
	6. Click OK. 


	Word 2007 and 2010 Versions 
	1. On the page of your Table of Contents, choose the Home menu tab & expand the Paragraph section. 
	1. On the page of your Table of Contents, choose the Home menu tab & expand the Paragraph section. 
	1. On the page of your Table of Contents, choose the Home menu tab & expand the Paragraph section. 

	2. Then choose Tabs. 
	2. Then choose Tabs. 

	3. Put in the Tab Stop Position, normally 6.5 (this is the distance to the right that the dot leaders extend, normally place it at the right edge of your document, you can use the number from the ruler bar at the top of your document if displayed, it is the right margin). 
	3. Put in the Tab Stop Position, normally 6.5 (this is the distance to the right that the dot leaders extend, normally place it at the right edge of your document, you can use the number from the ruler bar at the top of your document if displayed, it is the right margin). 

	4. Choose Alignment Right. 
	4. Choose Alignment Right. 

	5. Choose Leader as Type 2. 
	5. Choose Leader as Type 2. 

	6. Click OK. 
	6. Click OK. 


	 
	Now type in your chapter/section heading & then press the Tab key, this will extend the dot leaders over at which time you can type in your page numbers (page numbers can be inserted later and/or changed).  
	  
	Page Numbering 
	Page numbering—position at the bottom center; title page set to i, not displayed; abstract, table of contents, etc. set page number to start at ii, displayed at the bottom center; Introduction set page number to 1 & continue page numbers throughout the rest of the manuscript. 
	 
	Word 1997-2003 Version 
	1. From the Title page, place your cursor at the top of the page. 
	1. From the Title page, place your cursor at the top of the page. 
	1. From the Title page, place your cursor at the top of the page. 

	2. Choose Insert from the top menu bar. 
	2. Choose Insert from the top menu bar. 

	3. Select Page Number. 
	3. Select Page Number. 

	4. Select Position, choose Bottom of Page. 
	4. Select Position, choose Bottom of Page. 

	5. Select Alignment, choose Center. 
	5. Select Alignment, choose Center. 

	6. Uncheck Show number on first page. 
	6. Uncheck Show number on first page. 

	7. Click on Format. 
	7. Click on Format. 

	8. Select Number Format, choose the i, ii, iii option. 
	8. Select Number Format, choose the i, ii, iii option. 

	9. Click OK twice. 
	9. Click OK twice. 


	Word 2007 and 2010 Versions 
	For the Title page and Table of Contents: 
	1. From the Title page, place the cursor at the top of the page. 
	1. From the Title page, place the cursor at the top of the page. 
	1. From the Title page, place the cursor at the top of the page. 

	2. Choose Insert from the top menu bar. 
	2. Choose Insert from the top menu bar. 

	3. Under Header & Footer, choose Page Number. 
	3. Under Header & Footer, choose Page Number. 

	4. Select Bottom of Page. 
	4. Select Bottom of Page. 

	5. Choose Centered (Plain Number 2) (Option 2). 
	5. Choose Centered (Plain Number 2) (Option 2). 

	6. Click on the Design tab in the top menu bar. 
	6. Click on the Design tab in the top menu bar. 

	7. Under Options, choose (check) Different First Page. 
	7. Under Options, choose (check) Different First Page. 

	8. Click on the Design tab in the top menu bar. 
	8. Click on the Design tab in the top menu bar. 

	9. Under Close, click Close Header and Footer. 
	9. Under Close, click Close Header and Footer. 

	10. (Instead of 8 & 9, you can also double-click within the body of the document). 
	10. (Instead of 8 & 9, you can also double-click within the body of the document). 

	11. Choose Insert from the top menu bar. 
	11. Choose Insert from the top menu bar. 

	12. Under Header & Footer, choose Page Number. 
	12. Under Header & Footer, choose Page Number. 

	13. Choose Format Page Numbers. 
	13. Choose Format Page Numbers. 

	14. Under Number Format, choose from the drop-down menu i, ii, iii… 
	14. Under Number Format, choose from the drop-down menu i, ii, iii… 

	15. Choose Start at: (should default to i). 
	15. Choose Start at: (should default to i). 

	16. Click OK. 
	16. Click OK. 


	For the Introduction and following pages: 
	L
	Span
	1. From the first page of the Introduction, place the cursor at the top of the page. 
	1. From the first page of the Introduction, place the cursor at the top of the page. 

	2. Choose Page Layout from the top menu bar. 
	2. Choose Page Layout from the top menu bar. 

	3. Under Page Setup, choose Breaks. 
	3. Under Page Setup, choose Breaks. 

	4. Choose Next Page (4th selection). 
	4. Choose Next Page (4th selection). 

	5. Choose Insert from the top menu bar. 
	5. Choose Insert from the top menu bar. 

	6. Under Header & Footer, choose Page Number. 
	6. Under Header & Footer, choose Page Number. 

	7. Select Bottom of Page. 
	7. Select Bottom of Page. 


	8. Choose Centered (Plain Number 2) (Option 2). 
	8. Choose Centered (Plain Number 2) (Option 2). 
	8. Choose Centered (Plain Number 2) (Option 2). 

	9. Put your cursor at the beginning of the first page that will be numbered differently. 
	9. Put your cursor at the beginning of the first page that will be numbered differently. 

	10. Click on the Page Layout Tab at the top of the screen and Click Breaks. 
	10. Click on the Page Layout Tab at the top of the screen and Click Breaks. 

	11. Click Continuous Break and then click OK. 
	11. Click Continuous Break and then click OK. 

	12. Click on the Insert Tab at the top of the screen and click Footer. 
	12. Click on the Insert Tab at the top of the screen and click Footer. 

	13. Click Edit Footer. 
	13. Click Edit Footer. 

	14. Select the first Footer that will be numbered differently. 
	14. Select the first Footer that will be numbered differently. 

	15. On the Header & Footer Tools Tab Click Page Number. 
	15. On the Header & Footer Tools Tab Click Page Number. 

	16. Click Format Page Numbers. 
	16. Click Format Page Numbers. 

	17. In the Number Format drop down box, Click the format for 1, 2, 3… 
	17. In the Number Format drop down box, Click the format for 1, 2, 3… 

	18. Click OK. 
	18. Click OK. 

	19. On the Header & Footer Tools Tab, Click Close on the far right. 
	19. On the Header & Footer Tools Tab, Click Close on the far right. 


	 
	Excel Page Numbers: 
	Once you have your final document done (including the title page, table of contents, copyright page, acknowledgements, etc.), find out what your last page number is in the Word document. 
	Then open Excel and start placing page numbers on each sheet starting with the next page value beyond your Word document (be sure to format the font the same as the Word document). 
	For worksheets in portrait orientation, choose Print Preview, Page Setup, Header/Footer tab, Custom Footer, and place the correct page number in the center footer box (remember to make it the same font as in your Word document) and then click OK twice. 
	For worksheets in landscape orientation, find the center vertical cell in Column A, type in the correct page number (remember to make it the same font as in your Word document), then press CTRL-1 key sequence, Alignment tab, Alignment Grid and either move the line to the vertical bottom or set the degrees at -90.  
	 
	  
	Guidelines for Non-Thesis Options 
	 
	Students who choose to follow the applied (non-thesis) track must complete 6 hours of directed project or sociological practice internship in addition to the required coursework. Additionally, non-thesis track students must submit a portfolio as an additional requirement for graduation, which must be approved by a committee. Guidelines and requirements for directed projects, sociological practice internships, and the portfolio follow. 
	 
	Option 1: Directed Project 
	 
	All students pursuing a research non-thesis option will be required to hold a research planning meeting with their research advisor in order to outline the research plan and seek guidance and expectations prior to submitting IRB materials and engaging in the research process.  Students should schedule this research planning toward the beginning of the semester they first enroll in project hours (SOC 851) (usually in the Fall semester of their second year). The final document should include a literature revi
	Basic Quantitative Research 
	For students conducting basic research, the student and their advisor should review and agree upon a research plan including central research questions, preliminary hypotheses, the dataset to be used, and appropriate statistical techniques.  The student will then submit IRB materials before engaging in the research process. Students will use secondary data to facilitate timely completion of their project and MA degree. Datasets should come from widely accepted social science sources (such as ICPSR or IPUMS)
	Basic Qualitative Research 
	The faculty encourage the use of formalized data management software when appropriate. Common Computer Assisted Qualitative Data Analysis (CAQDA) options include software such as Excel, Dedoose, N-Vivo, or Atlas-ti for managing and analyzing qualitative data. 
	Interviews & Focus Group-Based Research 
	For students conducting interview based research (individual or group), the student and their advisor should review and agree upon a research plan including central research questions, preliminary hypotheses, and the number and structure of the interviews or focus groups.  The student will then submit IRB materials before engaging in the research process. There should be 
	enough interviews or focus groups to provide for sufficient diversity and recognition of essential patterns in the data. Also, there should be a systematic analytical process which delineates the coding methodology. In order to demonstrate a thorough grasp of the data, interviews should be transcribed by the graduate student with faculty advisor oversight.  An interview or focus group protocol would be included as an appendix to the project document along with coding examples rather than complete transcript
	Ethnographic Research 
	For students conducting ethnographic research, the student and their advisor should review and agree upon a somewhat focused research plan including information regarding central research questions, research location(s) and protocol, length of time in the field, and plans for ensuring the safety of the student. The student will then submit IRB materials before engaging in the research process. The main source of data for an ethnographic project will be the student’s fieldnotes and any other existing documen
	Case Study 
	For students utilizing a case study methodology, the student and their advisor should review and agree upon a somewhat focused research plan including information regarding central research questions, research location(s) and protocol, the boundaries of “the case,” and the different types of data to be collected (observation, survey administration, key informant interviews, document analysis, etc.) along with related protocols. The student will then submit IRB materials before engaging in the research proce
	Content Analysis 
	For students engaging in a content analysis, the student and their advisor should review and agree upon central research questions, the available data source(s) and level of analysis, as well as an appropriate sample size given the level of analysis and types of analytic procedures decided upon. If appropriate, the student will then submit IRB materials before engaging in the research process. Larger samples are appropriate when the material is brief (i.e., news articles) and the coding less detailed; small
	Evaluation/Applied Research 
	For students conducting evaluation or applied research for an agency or program, the student, their advisor, and the agency/program staff-person should review and agree upon a research plan including central research questions, preliminary hypotheses, the data to be used, and appropriate methodological and analytical techniques.  These projects may use already existing data from an agency or program, or data may be collected or compiled by the student.  Given that these projects are expected to be conducted
	 
	Option 2: Sociological Practice Internship 
	 
	The Sociological Practice Internship integrates academic theory with planned professional experience providing students with practical skills training under academic supervision to complement the student’s academic program.  Individualized programs must be formulated in consultation with and approved by appropriate faculty sponsors as well as the Career Development Center. 
	Students using the internship option will complete 6 hours of internship credit (SOC 781N) under the direction of one faculty advisor (6 credit hours equals 270 hours of work, according to university guidelines). In order to enroll in Internship hours, faculty advisor consent and registration with the College of Liberal Arts & Sciences Cooperative Education/Career Development Center representative are required. These hours may be with one agency, program, or business, or may be at a combination of agencies,
	Internship Paper 
	Learning objectives will be developed collaboratively with the internship/work supervisor and Sociology faculty advisor. As part of the final requirements, the student will compile and submit a paper documenting what they have learned and projects they have completed during the 6 hours.  While the specific requirements and format of this paper will be decided upon with the advisor, the paper should include the following: 
	L
	Span
	 Description of the Agency/Organization: Describe the nature or purpose of the agency or organization as well as its relevant history or background.  
	 Description of the Agency/Organization: Describe the nature or purpose of the agency or organization as well as its relevant history or background.  


	 Description of the Internship Experience: Describe your role as an intern, including tasks or activities performed and key characteristics of your internship site. Explain how the internship experience (and/or research project) is situated within the agency or organization (what is the relation of your work as an intern to the program goals?).How did your role shape your observations or research efforts within the agency or organization? 
	 Description of the Internship Experience: Describe your role as an intern, including tasks or activities performed and key characteristics of your internship site. Explain how the internship experience (and/or research project) is situated within the agency or organization (what is the relation of your work as an intern to the program goals?).How did your role shape your observations or research efforts within the agency or organization? 
	 Description of the Internship Experience: Describe your role as an intern, including tasks or activities performed and key characteristics of your internship site. Explain how the internship experience (and/or research project) is situated within the agency or organization (what is the relation of your work as an intern to the program goals?).How did your role shape your observations or research efforts within the agency or organization? 

	 Sociological Analysis: What is the sociological significance of your experience and observations within this agency or organization? Identify relevant sociological perspectives, theories, or concepts to understanding the agency/organization, its role or relationship to the surrounding community, and your role within it. Your analysis may have to do with interpersonal, group, organization, community, national, and/or global relationships, and you may want to demonstrate the relationships between these leve
	 Sociological Analysis: What is the sociological significance of your experience and observations within this agency or organization? Identify relevant sociological perspectives, theories, or concepts to understanding the agency/organization, its role or relationship to the surrounding community, and your role within it. Your analysis may have to do with interpersonal, group, organization, community, national, and/or global relationships, and you may want to demonstrate the relationships between these leve

	 Critique: Identify problem areas you experienced or observed in your internship. This may also include a self-evaluation of work performed. 
	 Critique: Identify problem areas you experienced or observed in your internship. This may also include a self-evaluation of work performed. 

	 Conclusion and Recommendations: Identify how problem areas may be addressed or how dynamics or outcomes within the agency or organization may be improved. Recommendations should be grounded in sociological perspectives, theories, and research. Finally, identify how the internship experience developed skills or professional goals.  
	 Conclusion and Recommendations: Identify how problem areas may be addressed or how dynamics or outcomes within the agency or organization may be improved. Recommendations should be grounded in sociological perspectives, theories, and research. Finally, identify how the internship experience developed skills or professional goals.  


	If a student completes two 3-hour internships at separate agencies or organizations, they will complete an Internship paper for each of those experiences.  
	 
	Option 3: Combined Research and Internship 
	 
	Under the direction and with the approval of their faculty advisor, a student may design a program that meets sociological and educational goals which combines an internship experience with a research project.  This student would take 3 research project hours (SOC 851) and 3 hours of internship credit (SOC 781N) under the direction of one faculty advisor. If appropriate, the student will submit IRB materials before engaging in the research process. Guidelines outlined above for directed projects and interns
	 
	  
	Guidelines for Completing the Portfolio Requirement 
	 
	For completion of the non-thesis MA degree, students must compile and submit an extensive portfolio documenting what they have learned and projects they have completed during the 6 hours.   
	Format 
	Portfolios can also be organized in paper format or electronic format, using “WordPress” or other appropriate electronic applications. Specific format requirements will be decided upon with the advisor. A final electronic copy of the portfolio should be sent to the graduate coordinator once approved.  
	Contents 
	The portfolio should include the following items: 
	 Cover page 
	 Cover page 
	 Cover page 

	 Table of Contents 
	 Table of Contents 

	 CV or Resume 
	 CV or Resume 

	 Program Reflection Statement  This statement should include the following: 
	 Program Reflection Statement  This statement should include the following: 

	o Reflect on your career goals  
	o Reflect on your career goals  
	o Reflect on your career goals  

	o Identify specific skills or knowledge developed during program 
	o Identify specific skills or knowledge developed during program 

	o Connect your work or research experiences with your knowledge 
	o Connect your work or research experiences with your knowledge 

	o Describe your intellectual and personal growth 
	o Describe your intellectual and personal growth 


	 Papers from directed project or internship 
	 Papers from directed project or internship 

	o Internship papers from each internship 
	o Internship papers from each internship 
	o Internship papers from each internship 

	o One final directed project document (unless 2 separate projects, then report for each) 
	o One final directed project document (unless 2 separate projects, then report for each) 


	 Beyond these required elements, you may include additional pieces as suggested by your chair: 
	 Beyond these required elements, you may include additional pieces as suggested by your chair: 

	o Presentations (slides) 
	o Presentations (slides) 
	o Presentations (slides) 

	o Reports or articles  
	o Reports or articles  

	o Materials developed (teaching materials, reports, brochures) 
	o Materials developed (teaching materials, reports, brochures) 

	o Evaluations from internship supervisors 
	o Evaluations from internship supervisors 



	  
	Timeline for Completing the Non-Thesis Requirements 
	Students will form a portfolio committee toward the beginning of the semester they first enroll in project hours (SOC 851) or sociological practice internship (SOC 781N) (usually in the Fall semester of their second year). The committee should include a chair (ideally the advisor for the directed project or internship) and a reader (another graduate faculty member from the Sociology Department or a graduate faculty member from another department with relative expertise). Students should schedule regular mee
	Complete portfolios should be submitted no less than 2 weeks before the last day of classes in that semester to the committee to review and approve. This allows time for revisions if necessary. A final version of the portfolio must be approved by the end of the semester in order to meet requirements for graduation.  
	 
	 
	 
	  
	Important Links from Graduate School 
	 
	Make sure to familiarize yourself with Graduate School policies and deadlines.  
	 The Graduate School website can be found 
	 The Graduate School website can be found 
	 The Graduate School website can be found 
	 The Graduate School website can be found 
	here
	here

	  


	 The Graduate Catalog can be found 
	 The Graduate Catalog can be found 
	 The Graduate Catalog can be found 
	here
	here

	 


	 The graduation deadlines can be found 
	 The graduation deadlines can be found 
	 The graduation deadlines can be found 
	here
	here

	 


	 The complete guide for thesis formatting can be found 
	 The complete guide for thesis formatting can be found 
	 The complete guide for thesis formatting can be found 
	here
	here

	 



	  
	Graduate Assistantships: 
	 
	The department offers a limited number of Graduate Assistantships (GA) each year on a competitive basis.  These awards are made through funding provided by the Graduate School and the Fairmount College of Liberal Arts and Sciences. These positions serve as apprenticeships for teaching and/or research in sociology.  GTAs are provided a monthly stipend and a partial tuition waiver of up to 75% and a 10% discount on books purchased for classes.  Each GTA is assigned to one or more faculty members and given off
	GTA Application Process and Terms of Re-Appointment: 
	Students who wish to apply for a GTA must submit an application to the Graduate Coordinator by the priority deadline (March 1st).  This application may be found on the Graduate School 
	Students who wish to apply for a GTA must submit an application to the Graduate Coordinator by the priority deadline (March 1st).  This application may be found on the Graduate School 
	website
	website

	. The number of GTA positions offered depends on available funding (approximately 8 positions have been available each year in recent years). The selection process is competitive and award decisions are made by the Sociology Graduate Admissions Committee each Spring for the following academic year.  The following criteria are utilized for the awarding of GTA positions: 

	 GPA (undergraduate or current graduate coursework) 
	 GPA (undergraduate or current graduate coursework) 
	 GPA (undergraduate or current graduate coursework) 

	 Background and coursework in Sociology 
	 Background and coursework in Sociology 

	 Strength of recommendation letters 
	 Strength of recommendation letters 

	 Ability to perform the duties of a GTA and meet the needs of faculty in the areas of teaching and research 
	 Ability to perform the duties of a GTA and meet the needs of faculty in the areas of teaching and research 

	 Review of other admission application materials (such as the personal statement) 
	 Review of other admission application materials (such as the personal statement) 


	 
	Graduate Students who have been awarded a GTA position may re-apply when the terms of their current GTA position expires by submitting an 
	Graduate Students who have been awarded a GTA position may re-apply when the terms of their current GTA position expires by submitting an 
	application
	application

	 by March 1st. (NOTE: There is a four-semester limit on GTA positions per student).  The following criteria are utilized for awarding GTA positions to current students: 

	 GPA of 3.00 or higher 
	 GPA of 3.00 or higher 
	 GPA of 3.00 or higher 

	 Satisfactory progress toward degree completion 
	 Satisfactory progress toward degree completion 

	 Satisfactory recommendations from supervising faculty 
	 Satisfactory recommendations from supervising faculty 

	 Continuing ability to perform the duties of a GTA and meet the needs of faculty in the areas of teaching and research 
	 Continuing ability to perform the duties of a GTA and meet the needs of faculty in the areas of teaching and research 


	 
	  
	Duties and Responsibilities 
	 
	Duties and responsibilities will vary depending on the faculty members to whom the GTA is assigned.  In general, GTAs are expected to become familiar with the Sociology department and its resources in order to assist students and faculty with research and academic functions.  GTAs also are expected to rotate with other GTAs in coverage of the department office if necessary throughout the semester.  The duties and responsibilities GTAs may be expected to perform are: 
	 attend lectures of the faculty member they are assisting 
	 attend lectures of the faculty member they are assisting 
	 attend lectures of the faculty member they are assisting 

	 design, administer, and grade exams and homework assignments 
	 design, administer, and grade exams and homework assignments 

	 prepare and present classroom lectures 
	 prepare and present classroom lectures 

	 hold office hours to meet with students regarding lecture/exam information 
	 hold office hours to meet with students regarding lecture/exam information 

	 develop bibliographies for faculty or office resources 
	 develop bibliographies for faculty or office resources 

	 assist faculty through campus library research for classes, presentations, and research 
	 assist faculty through campus library research for classes, presentations, and research 

	 assist in curriculum development and evaluation 
	 assist in curriculum development and evaluation 

	 provide support to the department (office coverage, tabling at events, etc) 
	 provide support to the department (office coverage, tabling at events, etc) 

	 assist with departmental projects (such as developing recruitment materials or assembling information regarding the job market, PhD programs, etc) 
	 assist with departmental projects (such as developing recruitment materials or assembling information regarding the job market, PhD programs, etc) 


	 
	GTAs are prohibited from grading coursework of their graduate student peers. 
	General information about graduate assistantships and Graduate School policies will be covered in a mandatory GTA workshop each year. Please see the Graduate School’s 
	General information about graduate assistantships and Graduate School policies will be covered in a mandatory GTA workshop each year. Please see the Graduate School’s 
	University Assistantship Policies
	University Assistantship Policies

	 for more information.  

	 
	Hours 
	 
	GTAs are expected to work a set number of hours per week (i.e., 10, 15, 20) for the entire semester.  The number of hours to be worked will be outlined in the contract for employment.  In general, GTAs will find that some weeks you will put in all your assigned hours, other weeks you will put in less.  The Graduate School forbids GTAs from putting in more hours than what they are assigned.  All GTAs are expected to keep a ledger of their hours and duties to be submitted to the Graduate Coordinator on a week
	 



